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LOG INTO YOUR ACCOUNT
ENTOURAGE SITE:

In the upper right-hand corner, click LOGIN, 
then enter your User ID and Password.

***User IDs and Passwords for the Primary 
Contact are emailed within 24 hours of 
signing, please contact your Account 
Manager if you did not receive an email.

Next, out of the Project List that appears, click 
OPENnext to your current yearbook project.

www.entourageyearbooks.com
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YOUR YEARBOOK HOMEPAGE:
The three large buttons, Upload Photos,View Deadlines, and Design Pages, are the main tools used to 
create a yearbook. These buttons provide quick access to these core features.

ACTIVITY NEWSFEED:  Keep track of your account activity. The 
newsfeed feature displays various updates and activity in your 
account (i.e. photo uploads, Entourage announcements, and 
more).

The Manage tab 
allows you to edit 
your book specs and 
account information, 
setup your staff and 
their permissions, 
access your 
yearbook ladder and 
any content that has 
been uploaded.

The Upload tab 
provides quick access 
to the Upload Photo 
and other upload 
features, such as 
uploading PDFs and 
videos.

The Collaborate tab 
allows you access to 
Explore, Share, 
Discuss, and Learn. 
These sections include 
our Template library, 
the Yearbook Contest, 
Certification tests, etc.

The Design tab 
gives you design 
access to the 
different parts of 
your yearbook such 
as the cover, index, 
and general pages, 
as well as your 
People Pages. You 
can also request a 
Design Review from 
this menu.

The Request tab 
gives you the option 
to request a Proof 
Book, Marketing 
Materials, and/or a 
Yearbook Kit.

The Help tab is your 
key to contacting 
Entourage with any 
questions you may 
have. There are 
online tools to help 
you right away. You 
can also sign up for  
our free online training 
sessions via our 
webinar calendar.

Getting Started

5



Accessing Your AccountMANAGE ACCOUNT Getting Started

ACCOUNT INFORMATION:
Here you can update your contact information, page count, 
book quantity, and even your delivery date. 

In the Manage Account section you can find your Account Manager,
Sales Rep, and the Billing Departments direct contact information. They are at 
your service for any assistance you may need throughout the yearbook 
process.

If you create more than one 
yearbook with our software, 
we offer cloning of one 
project to another using the 
IMPORT ACCOUNT CONTENT 
button.
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MANAGE YOUR TEAM:

ADD STAFF MEMBERS

The Manage Staff page is where you can add each member of your team by creating them new login information, 
or invite staff members from previous projects to keep the login information they already use.

Create your new team 
member logins here!

The 3 STAFF MEMBER TYPES:

1. ADMIN - Recommended for the Primary 
Contact and those who need full design and 
account/invoice access.

2. EDITOR - Recommended for students and 
those who require access to the designer 
and the Collaborate tab.

3. USER - Recommended for those who need 
only limited access to the website, such as 
Manage and Upload Photos.

These types can be customized via the Manage 
Permissions page. 7



UPLOAD AND MANAGE PHOTOS
ORGANIZE YOUR PHOTOS:
Utilize the Manage Photos page to organize your library of photos before or as you 
upload.  This page is integrated with Instagram, Facebook, Google Drive, Dropbox, our 
own Mobile App, and email submission.

To begin, create your photo categories by clicking on the Upload 
New Photos button, then Create Photo Category. You can also 
designate an existing category as a Parent category when 
creating a new category to make a folder within a folder.

Once your category is selected, click on the Upload New Photo 
button.  To upload photos from your files, click Browse and 
navigate to the photo file(s) on your computer.

Each category that you create will be automatically assigned an 
email address. The list of addresses can be found in the Email 
Photos button. 

Provide parents, teachers, and other members of the school 
community with the corresponding email address(es). Any 
attached or embedded photos will automatically upload to that 
specific category once the email is sent.
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UPLOAD AND MANAGE PHOTOS Getting Started

Upload PDFs to the Website

Re-signed accounts have the ability toImport Previous Year 
Photos. You will be able to choose an old category and import it 
with the pictures to your new account.

Log into your social media to use photos from your 
Instagram, Facebook, Google Drive, and Dropbox 
accounts.

If you have any PDF files you need to upload to the project, you can do 
so in the Manage Uploads section. 

You can view any PDFs that 
have been previously uploaded 
to the account here.

Click the Upload Filebutton. You can 
then select any cover or page design 
PDFs you created  in an outside 
program like Illustrator, Photoshop, or 
InDesign. Designate the content type 
and any appropriate comments, then 
click Upload File button to complete 
the process.
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MANAGE LINK Getting Started

LiNK is a separate website that serves as a "link" between your project and the 
the school community. Manage LiNK allows you to activate online yearbook 
and ad sales, photo submission on the desktop and mobile app, view the 
eYearbook, and create hosted Link pages and polls.

Check the boxes to 
activate the items 
that you would like to 
make available to 
LINK users. Click 
Confirm LiNK Changes 
to update.

This is how the LiNK home 
page appears. Users will 
be required to create 
their own login (separate 
from your staff logins) and 
will search by your 
yearbook account title.

The LiNK Site:    link.entourageyearbooks.com

Purchase, Upload, and 
Design buttons will only be 
available once the 
corresponding setting is 
turned on in Manage LiNK.

See page 42 for more about the LINK site!
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MANAGE DEADLINES/INVOICES
In Manage Deadlines, you will find several key submission dates based on your 
current delivery date. If you choose to change your delivery date, these dates 
will adjust automatically. Contact your account manager if you have concerns 
about these dates.

The First, Second, and 
Third Submission dates 
are also proof book 
request deadlines. 
See page 15 for more 
about the Request 
Proof Book feature.

Pay Invoices Online Anytime! You have the ability to 
pay your invoice anytime 
before your Final Approval 
date by going to the 
Manage Invoices section.

Click Pay Now to submit 
credit card information or 
click Download to receive 
a printable PDF file to 
forward to your financial 
secretary.
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HOMEPAGE TOOLBAR

Log into your Facebook profile and 
access your photos to use in your 
yearbook. School Facebook pages are 
not accessible by this feature.

Aside from uploading PDF files, you have the 
ability to Upload Other Content such 
as .mov, .mp4, .csv, and .txt files. (Videos can be 
incorporated into the yearbook using QR codes.)

If you happen to have a file too large to upload 
directly from your computer, Entourage also has a  
Hightail feature.

* Make sure you contact your Account Manager and let 
them know you have uploaded via Hightail so they can 
make sure that the file is ready for you to place.

The Upload tab provides quick access to the Upload Photo and 
other upload features, such as uploading PDFs and videos.

12



The Design tab gives you design access to the different parts of your yearbook 
such as the cover, index, and general pages, as well as your People Pages. You 
can also request a Design Review from this menu.

Page Design: 
Choose a page to 
design from the 
ladder preview on 
the left side of the 
screen. You can 
then use the tools 
to design your 
pages.

Design Cover:
Create your cover, 
add spine text, and 
set an exciting theme 
for your yearbook.

Design People Pages:
In this section you can create student portrait 
pages in three steps. 
- Upload your portraits and student data. 
- Separate the students by class, grade, or 
teacher, then choose a template.
- Automatically flow all of your student portraits 
onto specified yearbook pages. 

Getting Started
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HOMEPAGE TOOLBAR Getting Started

The Collaborate tab allows you access to Explore, Share, Discuss, and 
Learn. These sections include our Template library, the Yearbook Contest, 
Certification tests, etc.

Browse Templates: Search through hundreds of topquality templates. Get ideas for 
your book and bookmark any template you like for quick access in the designer. You 
can bookmark the templates by checking the boxes under the template preview.

You can rate 
all of the 
templates on 
the website 
and search for 
the most 
popular ideas!

Yearbook Gallery: 
Need some 
inspiration? View 
hundreds of ideas 
from other schools 
across the country. 
Use the tabs to 
switch between 
several school types 
for age appropriate 
styles.
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Getting Started

The Request tab gives you the option to request a Proof Book, Marketing 
Materials, and/or a Yearbook Kit.

Resource Kits are materials that you can utilize to help 
guide you in your yearbook process. You can get a 
physical or PDF version of these resources.

Marketing Materials allow you to design and 
receive your own order forms and posters. Promote 
your yearbook sales and generate interest in the 
yearbook. This is also a way to share information 
about buying books and ads online as well as how 
to contribute photos. 

In order to request these features it is required 
to have have a minimum of 3 design points.

Contact your Account Manager to inquire further about the 
design points.

Proof Books are physical copies of your yearbook 
that can be used to check for clarity of images, 
layout, and spelling/grammar. Click Add to Cart 
below the first available proof book choice, fill 
out the delivery information, and click Confirm.

Proof books take 1 week plus shipping to arrive, 
so please order at least two weeks before final 
approval.

HOMEPAGE TOOLBAR

A ladder poster is also available with the Resource Kit.
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HOMEPAGE TOOLBAR
The Help tab is your key to contacting Entourage with any questions you may have. There 
are online tools to help you right away. You can also sign up for our free online training 
sessions via our webinar calendar.

Explore the Help Site for answers to 
frequently asked questions, chat in 
a yearbook forum with other 
advisors across the country, and 
view the Entourage newsfeed for 
recent updates and 
announcments.

The Contact Supportpage contains live chat 
and contact information for technical support 
and the billing department.

Schedule a Webinar for yourself or your class under 
the Webinar Training Sign-up page. There are three 
main training sessions to choose from:

1. Getting Started/ Entourage Website

2. Edonline Basics

3. People Pages

16



YEARBOOK LADDER
YOUR PAGE PLANNING HQ: 
​View your yearbook progress, assign pages to staff, designate page content, directly 
access pages to design, and more.

Page Numbering: 
Add page numbers 
to your yearbook 
pages. Simple and 
advanced options 
are available.

Spell Check Book: 
Review potential 
spelling errors page-
by-page. The 
feature will make 
approved 
corrections to your 
page(s) 
automatically.

Submit for 
Production: When 
you are ready to 
submit your book for 
production, this 
button will take you 
to the approval 
form.

Preview Yearbook: 
View the digital 
flipbook of your 
yearbook progress. 
You can also 
generate a PDF 
version of your book 
sent to an email 
address of your 
choice.

In these boxes you can assign pages to 
members on your team. You can also 
lock certain pages once they are 
complete to prevent further editing 
from non-admin staff members.

Preview/Approve 
Cover: Check 
several previews of 
your cover design 
and approve it 
when you are 
ready. Note: 
approving the 
cover will lock the it 
from any further 
editing.

You can access your designer by clicking on the Design Page button next to the 
corresponding page you would like to access.

Getting Started
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MANAGE YEARBOOK SALES 
ONLINE STORE SETTINGS: 
In the Manage Yearbook Sales section, set pricing, sales deadlines, 
and track sales progress.

In the blue boxed 
area, you can 
reference quantities 
sold and generated 
revenue to order an 
accurate number of 
books to be printed.

Setup Online Sales:
Activate your online store and set parameters, 
such as yearbook cost, optional tiered pricing, 
sales deadlines, required customer information, 
etc.

Personalized yearbooks are available as a sales 
option. This involves foil stamping the name of the 
student onto the front book cover.

18



Track Yearbook Sales records every online and offline sale made through your store. 
Information will include date of purchase, total amount paid, intended recipient, quantity 
ordered, and personalization text if applicable. Spreadsheet downloads are also available.

If you offer in-school sales, 
select Create New In-
School Sales Entry to 
record each sale. Please 
note that personalizations 
not purchased in the 
online store will only be 
produced if added 
through this feature.

MANAGE ONLINE AD SALES:

Setup Ad Pricing: Configure your 
pricing and add size options for 
family members and businesses to 
purchase.

Track Ad Sales: View and 
approve design and purchase 
ads before they can be placed in 
the page designer.

Getting Started
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Approve Book Content: 
This is the final review of all of your pages 
and pre-flight warnings. Click on the 
provided warning links to go directly to 
that affected page in the designer and 
make any necessary fixes. Fill out the 
bottom portion and click Approve.

APPROVE FOR PRODUCTION
FINAL APPROVAL FORM:
Navigate to the final approval form from the Manage tab, the Yearbook Ladder, 
or Manage Deadlines page. Begin with the red links at the top and complete 
each section before attempting to submit.

Final Payment Due: If not already paid in full, apply online revenue from yearbook and 
ad sales, supply credit card information, and/or online checking details now.

20



Approve Cover: 
If you have not already 
done so, check several 
previews of your cover 
design and approve it at 
the bottom of the page.

Set Delivery Information
Provide the name and delivery 
address for your order.

Note: PO Boxes are not valid 
shipping addresses.

You have the ability to choose a 
faster turnaround time but there will 
be a rush fee associated with the 
date (approximates shown).

The standard turnaround for yearbooks is 3 weeks plus shipping. 

Save your content for the next year 
using the approval form. Provide a 
new contact for next year if 
applicable. Re-sign for the next 
year to keep your pricing and 
upgrades. There are options to re-
sign for multiple years. 

Re-signs are non-binding. If you re-sign and decide to cancel you will 
not be charged or penalized.

Getting Started
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EDONLINE
DESIGNER

Part 2

Ready to start designing 
your book? This is your 
all-access pass on how 
to use the Designer
to create the best 
yearbook ever!
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ACCESS THE DESIGNER
Access the designer using the Design tab or Manage Ladder. Only one person can access a spread 
at one time. Entourage recommends using Google Chrome or Mozilla Firefox as your browser while 
you design your pages.

Note: Once we receive your initial deposit, your 
software will be fully activated. Until then, design access 
is limited to the first 7 pages and the cover.

Click the gray 
X to hide the 
Select Page 
side menu for 
pages and 
return to the 
left toolbar.

WHEN IN EDONLINE:
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Welcome to the designer! On the left side of the page is the Select Page menu. Select a spread 
to open the pages and begin your design.

EDONLINE PAGE GUIDES
While in the designer, these colored lines on the canvas 
will guide the placement of your content:

Red 
Guideline
This is the 
bleedline. All 
backgrounds 
should meet or 
exceed this line 
completely to 
ensure a clean 
bleed off the 
page.

Black 
Guideline
This is the trim line, 
where the pages 
will be cut during 
production. This 
designates the 
actual page 
edge in the final 
product.

Black Center 
Line
This is the center 
of your spread, 
where the pages 
will be bound to 
the cover. Make 
sure text or faces 
in pictures are not 
in this area.

Purple 
Guideline
This is your margin 
or "safe zone". Any 
items you do not 
want to get cut off 
must stay within the 
purple guidelines.

Click the red X button at the top right of your page in order to close the designer and 
return to your Ladder.

EDOnline Designer
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THE DESIGNER TOOLBARS

SAVE
Click this button to 
save your changes.

TOP AND LEFT TOOLBARS:

Copy 
Frame​

Paste 
Frame​

Undo

Redo

Fill
Color

Border
Color

Border
Width

Delete
Frame

Lock
Frame

Move to 
Front/
Back

Rotate

Insert Text

Preview Mode

Insert PDF

Insert Photo

Insert QR Code

Insert Template

Insert Background

Insert Approved Ads

Insert Shape

Page Builder

Move Pages

Edit Background Mode

Auto Grid

Recover Pages

Manage People Pages

Insert Clip Art
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VIEW TAB

PAGE TAB

FRAME TAB

AUTOMATE TAB

SETTINGS TAB

HELP TAB

In the View Tab,check the box next to the feature you would like to 
activate. WIth the Ruler, measure the dimensions in inches and 
distance of objects to the page edge. The Snap To feature will display 
a green line when an object edge aligns with the edge of another 
object while being moved. The Grid feature will overlay a transparent 
graph onto your page.

The Page Tab offers the options to mirror a page layout or 
clear a page when you want to start over from scratch.

The Frame Tab provides quick access to frame settings such as add 
drop shadows to an object, add rounded corners to a selected 
object, or apply wrap text to an image so that text wraps around its 
edges.

In the AutomateTab, you can manage your people pages. 
You can also access the index generator.

In the SettingsTab you can manage page locks that are 
created by your staff members. This is useful when a staff 
member does not properly close a spread. Deleting the 
page lock will allow other members to access the spread.

TheHelpTab is another way to access Entourage support 
documents and contact technical support.

EDOnline Designer
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ADD PHOTOS TO PAGES
Place Photos: 
Click on the Insert Photo button in the Insert Items section of the 
left toolbar. Select from your photo categories, then click on your 
desired photo and it will highlight in green. 

After you select the 
photo, click anywhere 
on the page canvas 
and it will appear!

If you have inserted a template, there 
will be Drop Photo boxes. After you 
select a photo, click inside a Drop 
Photo box and it will appear.

If a placed photo does not fit properly, 
you can adjust it by using the Photo 
Settings tab on the right hand side of 
the designer.
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Add a PDF

DROP PHOTO BOXES: You can insert these 
placeholder boxes as well!

These are useful at the beginning of your 
project if you want to design a page without 
having photos available for that page.

EDOnline Designer

Once you upload a PDF under Manage Uploads, you can 
place it on the page by clicking the Insert PDF button on 
the left toolbar.
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CLIP PHOTOS
When a photo is selected on the page, a photo edit toolbar will appear under the 
top toolbar. In this toolbar, select Clip to remove the background from an image.

Foreground 
Brush

Background
Brush

Erase
Marks

Scalpel

Zoom
In

Zoom
Out

Zoom to 
Fit

Save 
Edits

Mark as 
Done and Exit 
Clipping Editor

You are given 500 clipping credits at the start of your project.Each time you click Done 
you spend a point, so please use the clipping feature wisely. If you run out of clipping 
credits, or do not seem to have any, contact your account manager and they will be able 
to assist you in getting more!

Use Foreground Brush for everything you want to keep in the photo.
Use the Background Brush for anything you want to get rid off on the photo.
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ADD TEXT
Place Text: 
Select the Insert Text button in the Insert Items section of the left 
toolbar. Click on a default style and click onto the page to insert the 
text box.

Once the text is placed on the spread, and the text box is selected, a 
text editing toolbar will appear under the top toolbar. See more details 
on the next page.

You can also Save as New Text Style so that you can re-use 
your text settings later without the need to reformat your text 
each time you place a new text box.

EDOnline Designer
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EDIT TEXT
Once the text is placed on the spread, and the text box is selected, a text editing 
toolbar will appear under the top toolbar.

Select
Font

Bold Italicize
Underline

Font
Size

Font
Color

Text 
Alignment

Text Edit 
Mode

Choose from our selection of various fonts and styles that will fit your yearbook page 
or theme. "Busy" fonts, such as Boogie Nights, are recommended for headlines only.

EDOnline Designer
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ADD BACKGROUNDS & CLIPART
To add backgrounds, click the Insert Background button on the left toolbar. 
Select a category or search for a specific background type using the 
keyword search button. Click on the desired background and click onto the 
page to insert it. Some backgrounds are intended for placement on one 
page and others will cover an entire spread.

Add Clip Art to add to the 
theme of your page. There 
are plenty of different themes 
and categories to choose 
from to fit your idea. Use the 
keyword search bar or 
browse through the 
categories.

In order to edit the background you must be in Background Layer mode, found in the 
Actions section on the left toolbar. In this mode, you will be able to select or edit your 
background layer. 
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INSERT TEMPLATES
Choose from a multitude of templates we have to offer under our 
Templates section.  These pre-designed pages can give you a great 
starting point to build from and save your valuable time.

If there is content on the page when you insert a template, you will be prompted to replace or 
cover that existing content.

You have the ability to save your own pages as templates for later use. To 
Save as a Template, select the green down arrow next to the Save button.

You will have the option to save just a single page 
or the spread. Custom saved templates are not 
visibile to other accounts but can be accessed by 
your staff in the Templates button > Custom 
Templates category.

EDOnline Designer

34



MOVE PAGES & RECOVER PAGES

RECOVER PAGES

If you need to rearrange your pages, you can do so under the Move Pagesbutton 
in the actions section of the left toolbar.

The pop-up window that 
appears will allow you to click 
and drag spreads into a new 
order.

Click Commit Page Moves to 
save the changes or use Reset 
Page Moves to start over.

If you would like to move single 
pages at a time, click the 
Advanced  Page Moves 
button at the bottom right of 
the move pages pop-up 
window.

You may bump some pages  
into the unused page dock at 
the bottom of the screen. In 
order to save your changes, 
the dock at the bottom of the 
screen must be empty. You 
can drag and drop important 
pages back into the correct 
place in your book, or delete 
the blank or unneeded pages.

If you want to revert to a previous version of a spread, click on Recover Pages in 
the Actions section of the left toolbar.

You can choose 
between the last ten
saves of the spread.

35



PAGE BUILDER
Use Page Builder to place multiple photos in a template of your choice onto 
a blank page. Find this feature in the Actions section of the left toolbar.

This time-saving tool works in three quick steps:

Once you click on the Page Builder Icon a side menu will appear.

Step 1: Add Photos
Click on the Select New Photos 
button and your categories list will 
open. Choose the photos you want 
on the page. The selected photos 
will have a green border. Then click 
Add Selected Photos when you are 
finished with your selection.

Step 2: Choose Template
Click Choose Template to browse 
for your desired template. You may 
sort by category or by photo count, 
which will display templates that 
have the same quantity of photo 
spots available as selected in step 
one. Click Use Selected Template 
when your final choice is 
highlighted green.
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Step 3: Create Page
Click Create Page to view the generated template that Page Builder creates. You have the 
option to click Regenerate Preview so the photos shuffle around on your template or place the 
design on the left page or the right page once you are satisfied with the layout.

Once the template is placed on the page, you can adjust the photo within the photo frames using the Photo 
Settings tab on the right side of the designer. See page 38 for more details.

EDOnline Designer
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ADVANCED MENU
The Advanced Menu tabs give you more options to adjust and edit objects on the page. 
Click one of the tabs on the right side of the designer to expand those options.You must 
have a photo or text box selected to view the options within those tabs.

There are three Advanced Menu tabs: Photo Settings, Text Settings, andFrame Settings.

To easily close any of the Advanced Settings tabs, click the Advanced Menu button on the 
bottom of the designer.

Clear Image - Deletes the image, leaving the 
selected frame available for a new image.

Flip - Horizontally or vertically flip the image.

Fit - Gives several fitting options for the 
image. Use Manual to move the image 
within the frame without altering the frame 
size or shape.

The settings below the image preview allow 
you to change the image's position on the 
page, dimensions, rotation, and size within 
the frame.

Photo Settings
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Various border, color, and fill options can be 
found here. The Inset options customize the 
margins between the text and frame.

In addition to Font, Size, and 
Color options, this feature 
provides Baseline, Case, 
Tracking, Kerning, and 
Leading for more advanced 
text formatting.

Text Settings

This tab is most frequently used to add or lower the 
opacity of an image so that it appears lighter than 
usual. The lower the percentage, the more transparent 
the image will become.

EDOnline Designer

Frame Settings
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NEW IN EDONLINE
90s RETRO THEME NOW AVAILABLE! 
After popular demand we have now added "90s Retro" backgrounds, templates, and clipart. 
If you have suggestions for themes you would like to see in the future, please let us know!

Backgrounds!

Templates!
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THE LiNK SITE
Provide LINK.ENTOURAGEYEARBOOKS.COM to community users like parents, teachers, or friends. Here they can  
Upload Photos, Purchase Yearbooks, and Design Ads for your project.

Once on the site, they must 
Register with their own User ID 
and password to access the 
LiNK site. From there, they can 
search for the school's yearbook 
by name and use the features 
you have activated on your 
Manage LiNK section.

Use the Purchase Books button when ready to purchase a yearbook online. 
Follow the prompts for your order and check out before the deadline. Provide 
your email address to receive an electronic receipt.

The Design Yearbook Ad button will bring you to a list of available ad sizes 
and prices for purchase in your school yearbook. These can be used for 
personal pages for students or business advertisements. 
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Click Upload Photos to 
view the available 
categories for submission. 
Select the desired 
category from the 
dropdown menu then click 
Browse. Choose photos 
and click Open to begin 
the upload.

If you need more Design Points to request a Proof Book 
or Marketing, you can purchase more points here in LiNK. 
Just click the Purchase Design Points button!

DOWNLOAD THE 
MOBILE APP
With the mobile app, LiNK users have the ability 
to upload photos to your categories directly 
from their phones. Make sure you are registered 
in the LiNK site first in order to log into the mobile 
app. 

*Make sure permission for the mobile app is 
turned on under the Manage LiNK section of 
your yearbook account.

LiNK SITE & Mobile App!
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MARKET YOUR

YEARBOOK

Part 3

Want to know how 
to promote and market 
your yearbook at school?
Here are some helpful tips 
on how to do so!
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How to MARKET YOUR YEARBOOK
Introduction

46



Market Your Yearbook
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CREATE A SALES PLAN
Book Sales Preparation
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Market Your Yearbook
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ADVERTISEMENT STRATEGIES
Pre-Sales and Promotions
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Market Your Yearbook
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ADVERTISEMENT STRATEGIES
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BUSINESS ADS
Selling to a Business
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Market Your Yearbook
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